Microsoft Excel tutorial 1
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1. Clearing cells

1. To select a single cell to be cleared, left click the pointer on the cell you want to clear. To select a range of cells, left click on the upper-left corner of the range and hold the mouse button down while dragging the pointer to the lower right corner of the range and then release it. 

2. Click Edit on Menu. 

3. Find and select Clear. 

4. Select Contents to clear only the contents of the cell, or click All to clear the contents, formatting, and notes of the cell. 

2. Using the fill handle

1. Select the cell that contains the formula, value or label that you want to copy. This is the active cell.
2. If there is more than one cell contents that needs to be copied, select the range by selecting the active cell and draging the pointer until the entire range of cells is selected.
3. Position the mouse pointer over the fill handle which is the small black square at the lower-right corner of the active cell (s).
4. The pointer changes to a ' + ' sign.
5. Hold down the left mouse button and drag it to cover the entire range of target cells.
6. Release the left mouse button.
7. To deselect the range just click on any cell on the excel worksheet.


Quick Way 
Highlight the cell or cells you want to copy and also the adjacent cells where it is to be copied.
2. In order to copy the selected column to the adjacent cells on the right ,select the Edit Menu and click on Fill and choose Right . Alias : Use CTRL in the keyboard + R 
3. To copy the selected first row into the adjacent cells below,select the Edit Menu and click on Fill and choose Down . Alias : Use CTRL in the keyboard + D 
4. Similarly to copy the selected column to adjacent cells above use Fill - Up .
Alias : Use SHIFT in the keyboard + Fill-Down in the menubar. 
5. Similarly to copy the selected column to adjacent cells on the left use Fill-Left . 
Alias : Use SHIFT in the keyboard + Fill-RIght in the menubar.

Using the FillHandle is one way of copying formulas, labels or values from one range to another range of cell (s) in the same row or column. 
FillHandle is the name of the small black square button on the bottom right corner of the selected cell.

3. Text, Values, Formulas, And Functions 
In this lesson you will learn how to enter text, values, formulas, and functions into a worksheet. Text is often used to label columns and rows in a worksheet. Values are numbers enter on cells. A formula helps you to calculate and analyze values in your worksheet. A function is a ready-to-use formula that performs a specialized calculation on you worksheet. 

1. To enter text in a worksheet, click the cell where you want to enter the text, then type the text (example: John Jones). 

2. To enter a value, click the cell where you want to enter data. Then type the value (example: 304, 296). Press Enter on your keyboar to move down one cell. 

3. To enter a formula, begin by typing an equal sign (=) on a cell. Then use cell references (example: =c4+d4) instead of actual data (example: =304+296) whenever possible. Then Press Enter on your keyboard. 

4. To enter a function, click the cell where you want to enter it, then click the function icon on the tool bar or type the function name (example: =Average(c4:d4) on the cell. The Paste function dialog box appears. Click the category that contains the function you want to use, then click OK. A dialog box appears. Then enter the cell locations (example, c4, d4) of the data, then click OK. 

4. Inserting Rows and Columns 
1. Select the cell(s) close to which you want to insert a Row or Column. Remember that Rows will be inserted above that point and Columns will be inserted to the left of it. 

2. Select Insert Menu andd select Row or Column depending on what you need. 

 Entering Formulas 

1. Click on your chosen cell to begin.
2. Type "=" to begin all formulas.
3. Choose from the following for the appropriate arithmetic operation for the formula.
Addition Example =A1+A2 
Subtraction Example =A1-A2 
Multiplication Example =A1*A2 
Division Example =A1/A2 
Exponetiation Example =A1^A2 
4. Type the formula in the cell where the result should appear.
5. Press Enter to compute the formula. 


6. Autosum 
1. Highlight the cell in which you want to put the sum. 

2. Click Function Wizard/Paste Function icon on the Insert menu. 

3. Click Math & Trig in Function Category. 

4. Select Sum from the Function Name. 

5. Click Next/OK. 

5. Enter the range of cells (the first and the last cell) in number 1 box, separated by a colon. 

6. Click Finish 

Quick Way 
Method a:
1. To put the sum immediately next to the range of cells, select the range of cells of which you want the sum. 

2. Click Autosum icon or enter Alt + = from the key board. 

Method b:
1. To put the sum elsewhere in the worksheet, highlight that cell. 

2. In the Formula bar or in the cell in which you want to enter the sum, type "=" to begin the function. 

3. Type SUM or sum, immediately followed by an opening parenthesis "( ". Remember not to put a space in between. 

4. Enter the range of cells (the first and the last cell), or drag the pointer to highlight the cells you want to sum. 

5. Close the parenthesis and hit the Enter key.

7. Relative Cell References in Copying a Formula

1. Consider for example that the contents in cell C3 are a result of application of the formula (A3+B3)*C3 .
2. Click the left mouse button on the cell C3 .
3. The formula in step 1 appears there. 
4. Using one of the copy commands copy the contents in cell C3 to C4 (in this case you are copying the formula) . 
5. Then click on cell C4. The formula appears as (A4+B4)*C4 . 
6. Thus it is clear that Excel has adjusted the cell references to suit the new locations. 

8. Absolute Reference


First of all, we talk about cell referencing when a cell "points" to an other. For example, in the formula C3=A1+A2, cell C3 "points" to cell A1 and cell A2. 

There are three types of references viz., Relative Reference, Absolute Reference and Mixed Reference. 

A relative reference is a cell reference that changes when the pointing cell is copied to another cell. For example, if we copy the above formula to cell D4, the rsult will be: D4=B2+B3. As you can see, the "pointed" cells "move" according to the relative position of the "pointing" cell. 

An absolute reference, on the other hand, is a cell reference that does not change when it is copied to another cell. For example, if the original formula was: C3=$A$1+$A$2, then the formula that is copied to cell D4 is: D4=$A$1+$A$2 which is invariate. 

A mixed reference is one that changes only either the row number or the column letter. 

An absolute reference is used when a cell reference is required to point to the same location whenever you copy a formula that has this reference. To create this, a dollar sign $ is inserted before the column and row of the cell reference. 

Example
A cell reference 'C3' is a relative reference. When a formula containing this reference is copied to another cell, the reference to 'C3' changes. When it is required that the reference 'C3' in the formula should not change, a dollar sign $ is inserted before the column and the row of this reference - '$C$3'. 

In case when it is required that only either the row number or the column letter should change, a mixed reference is used. When the formula containing '$C3' is copied, only the row number changes. Similarly, when the formula containing 'C$3' is copied, only the column letter changes. 

1. To make a cell reference absolute, you need to place the dollar sign before the coordinates of the "pointed" cells.

2. You can obtain this result by typing the dollar signs in the appropriate position while you are typing the formula.

3. An alternative way is to highlight the cell reference and press the F4 key on the keyboard. 

4. To confirm the function hit the Enter key.

Selecting Non Adjacent Ranges

This function is used to select ranges of data that are not located next to each other. This function is often useful when creating charts because the data needed is often not side by side in the worksheet. For example, this function would allow you to select data labels from column A1:A9 along with your data series in column D1:D9. 
1. Highlight the first range of data you want to select. 

2. Press and hold down the Ctrl Key while you highlight additional ranges. 

3. After you have selected all the ranges you want to include, release the Ctrl Key and the mouse button.

DOING STATISTICS BY USING FUNCTIONS

The MAX function 

The MIN function 

The AVERAGE function 

The COUNT function 

The IF function 

The RANK function 

Displaying formulas 

The MAX Function 
Description of the Max Function

The MAX function gives the highest value number in a selected list of numbers, logical values, cell names, arrays, or combinations of these items. 

The MAX function must be entered in the following form: 

=MAX(argument 1, argument 2, ...) 

where (argument 1, argument 2 ...) are numbers, logical values, cell names, arrays, or combinations of these arguments from which you wish to find the maximum value. 

Up to 30 series of arguments can be entered in a single function. 

Empty cells, logical values, text, or error values in the argument lists are ignored. Also, if the arguments contain no numbers, MAX returns 0. 

The following examples will help clarify this description. 

Examples 

If cells A1:A5 contain the numbers 1,2,3,4,5, and 

if cells B1:B5 contain the numbers 6,7,8,9,10, then: 

MAX(A1:A5) = 5 (the max of numbers 1-5) 

MAX(A1:A5,B1:B5) = 10 (the max of numbers 1-5, & 6-10) 

MAX(A1:B5,20) = 20 (the max of numbers 1-10, & 20) 

The Function Wizard can also be used as simpler alternative to entering the MAX function text directly into the target cell. Directions for using the Function Wizard are given in the Quick Way section of the main MAX Function help page. The Function Wizard is a window-driven method designed to easily enter complex functions.

How to use the Max Function

1. Select the desired target cell in the worksheet to which you would like the MAX function to return its result. 

2. Select Insert from the menu Function.... 

3. Select Statistical from the Function Category list on the left side of the window. 

4. Scroll down to MAX in the Function Name list on the right side of the window. Select MAX. 

5. Click on the OK button. This brings up the MAX window. 

6. In the blank next to 'Number 1', enter the desired arguments. If you are selecting cells from the worksheet, you can click and drag the desired cells, and the Wizard will enter the selected cell names into the blank. 

7. If more sets of arguments are desired, click on the 'Number 2' blank, and enter your arguments. Repeat as necessary ('Number 3, 4, ...') 

8. Click on OK when done. 

The MIN function 

This function in excel allows you to find the lowest value in a list of values. 

How to use the min Function

Place the cursor in the box where you eventually wish the minimum to appear.

1. Select Insert.

2. Find and select Function. This will bring up a screen that asks for the type of function you wish to compute.

3. Select Statistical Function Category list on the left side of the window. 

4. On the right hand side find and select Min. Press OK.

5. In the blank next to 'Number 1', enter the desired arguments. If you are selecting cells from the worksheet, you can click and drag the desired cells, and the Wizard will enter the selected cell names into the blank. 

6. If more sets of arguments are desired, click on the 'Number 2' blank, and enter your arguments. Repeat as necessary ('Number 3, 4, ...') 

7. Click on OK when done. 

The AVERAGE function
1. Select the desired target cell in the worksheet to which you would like the AVERAGE function to return its result. 

2. Select Insert Menu. Then select Function.... 

3. Select Statistical from the Function Category list on the left side of the window. 

4. Scroll down to AVERAGE in the Function Name list on the right side of the window. Select AVERAGE. 

5. Click on the OK button. This brings up the AVERAGE window. 

6. In the blank next to 'Number 1', enter the desired arguments. If you are selecting cells from the worksheet, you can click and drag the desired cells, and the Wizard will enter the selected cell names into the blank. 

7. If more sets of arguments are desired, click on the 'Number 2' blank, and enter your arguments. Repeat as necessary ('Number 3, 4, ...') 

8. Click on OK when done. 

The COUNT function

The COUNT function counts the number of number values in the list of arguments in the brackets after the function name COUNT. The arguments may be an array or a reference representing the position of a cell. They may also be values, nulls, logical values or text representations but only numbers are counted. 

1. Select the desired target cell in the worksheet to which you would like the COUNT function to return its result. 

2. Select Insert from the menu. Then, select Function.... 

3. Select Statistical from the Function Category list on the left side of the window. 

4. Scroll down to COUNT in the Function Name list on the right side of the window. Select COUNT. 

5. Click on the OK button. This brings up the COUNT window. 

6. In the blank next to 'Number 1', enter the desired arguments. If you are selecting cells from the worksheet, you can click and drag the desired cells, and the Wizard will enter the selected cell names into the blank. 

7. If more sets of arguments are desired, click on the 'Number 2' blank, and enter your arguments. Repeat as necessary ('Number 3, 4, ...') 

8. Click on OK when done. 

IF function
The IF function returns a value based on a logical test. A logical test is any expression that can be evaluated as TRUE or FALSE (i.e. it is raining, or 5+3=8, or C3=87). 

If the Logical_Test is true an action will be taken, if the Logical_Test is false, a different action will be taken. For example, if the Logical_Test is true, the text "HELLO!!" will be displayed or, if the Logical_Test, a new IF function is evaluated. 

How to do
1. Select the desired target cell in the worksheet to which you would like the IF function to return its result. 

2. Select Insert from the menu. The select Function.... 

3. Select Logical from the Function Category list on the left side of the window. 

4. Scroll down to IF in the Function Name list on the right side of the window. Select IF. 

5. Click on the OK button. This brings up the IF window. 

6. In the blank next to 'Logical_test', enter the desired argument. The argument for this field is any expression that can be evaluated to either TRUE or FALSE. (i.e. C3>90). 

7. In the blank next to 'Value_if_true', enter the desired argument. The argument for this field can be anything ranging from text, numbers or other functions such as another IF function. 

8. In the blank next to 'Value_if_false', enter the desired argument. The argument for this field can be anything ranging from text, numbers or other functions such as another IF function. 

9. Click on OK when done. 

The RANK Function 

The RANK function calculates the rank of a number within a group of numbers. In other words, a number's rank is that number's size in relation to other numbers in the group. 

For example, when sorting a list of numbers, the rank of the number is its position in the list.

1. Select the desired target cell in the worksheet to which you would like the RANK function to return its result. 

2. Select Insert from the menu. Then, select Function.... 

3. Select Statistical from the Function Category list on the left side of the window. 

4. Scroll down to RANK in the Function Name list on the right side of the window. Select RANK. 

5. Click on the OK button. This brings up the RANK window. 

6. In the blank next to 'Number', enter the desired arguments. The argument will be a refernce to the cell containing the value of a the number which rank you are trying to find. 

7. In the blank next to 'Ref', enter the desired arguments. The argument will be the list of numbers among which you are trying to rank the value contained in the 'Number' field. 

8. In the blank next to 'Order', enter the desired arguments. The argument will be 0 if you desire the highest number to be ranked number one. A 1 if you want the lowest number to be ranked number one. 

8. Click on OK when done. 

Displaying Formulas 
1. Select Tools. 

2. Select Options 
3. Click the View tab. 

4. Under Window Options select Formulas .

Excel Macros

Macros are short programs which you can store in your Excel workbook. You would create a macro if you have any sequence of actions that you wanted to carry out regularly to modify your data. 

Note: These examples have been tested on Excel 8. In Excel 8 objects such as buttons and text boxes can be accessed by View/Toolbars/Forms. In this section we show how to record macros. 

Recording Macros

The macro languages for application packages such as spreadsheets and word processors were originally introduced to save (record) and repeat frequently used sets of keystrokes. Now programmers are likely to write complex routines in macro languages such as Visual Basic for Applications. Recording a macro is a useful starting point for coding, and may save us from having to remember some of the more obscure properties of Excel objects.

For example, the next section makes cells with values greater or equal to 1000 bold. But how to set a cell bold?

Start with a new spreadsheet. Select Tools/Options/Editor and make sure all boxes are checked, in particular Require Variable Declaration.

Select Tools/Macro/Record New Macro. Change the name to mbold, type b into the Ctrl box, and click OK. A Stop button appears.

Select the range A1:C4 with the mouse, then choose Format/Cells/Font and click Bold. Press OK, then press the Stop button.

Type some numbers into the selected cells to check that their format has changed. Now select A1:C4 again and set the font back to regular (you are not recording now). Then select some other cell, and press Ctrl-b. Cell A1;C4 should become bold again.

Now look in Tools/Macro/Macros. mbold (the only macro) will be selected. Click Edit and inspect the code. It should read as follows:

Option Explicit
Sub mbold()
'
' mbold Macro
' Macro recorded 27/05/97 by ismu
'
' Keyboard Shortcut: Ctrl+b
'
Range("A1:C4").Select
With Selection.Font
.Name = "Arial"
.FontStyle = "Bold"
.Size = 10
.Strikethrough = False
.Superscript = False
.Subscript = False
.OutlineFont = False
.Shadow = False
.Underline = xlUnderlineStyleNone
.ColorIndex = xlAutomatic
End With
End Sub
Note that what appear to be VBA comments are instructions to the editor.

You can see the hierarchy of objects and properties which have been used:

Range.Font.Fontstyle = "Bold"

(note also that the rest of the Font properties have also been set, although they weren't changed)

We will now adapt this code to our original purpose.

Looping Through a Range of Cells

We need to clarify our specification. Do we want the macro to operate on a fixed range of cells, or on the range of cells selected by the user. First let us assume that we want a fixed range, (A1:C4).

We wish to make only those cells bold which have a value >= 1000. This means that we will have to test individual cells and hence will need a loop. (We don't have one yet, because the Font property can refer to a complete Range.) The most common loop when working with spreadsheets loops through the objects in a collection - the For ... Each loop. This gives us the following code (without the extra Font properties):

Option Explicit
Sub mbold()
'
' mbold Macro
' Macro recorded 27/05/97 by ismu
'
' Keyboard Shortcut: Ctrl+b
'
Dim cell As Object
For Each cell In Range("A1:C4")
If cell.Value >= 1000 Then
cell.Font.FontStyle = "Bold"
Else
cell.Font.FontStyle = "Regular"
End If
Next cell
End Sub
If we wish our macro to work on a range of cells selected by the user, we just replace the For ... Each line with

For Each cell in Selection

(note that here cell is a variable, not a key word - though Cells is)

Note also that this macro fails if one of the cells has a non-numeric valu







